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Programming DotLok

This document describes how to program the DotLok unit with the uCal programmer, and how to use the sup-
plied software. The software runs on a PC or Laptop under Window 98, ME, 2000 or XP.

The programming kit consist of the programmer (uCal), a CD disk containing user manuals and software for a

PC or Laptop, and two cord sets. The cord sets connect the uCal programmer to the DotLok unit and to your
PC/Laptop.

Installing the uCal Software on your PC/Laptop

The CD contains an installation program (Install DotLok) that automatically installs the software and necessary
support files on your PC/Laptop.

uCal Programmer Version
The uCal programmer is available in two versions, serial (uCal) and USB (uCal USB).

The serial version (uCal) communicates with your Laptop/PC through the serial port (RS232). A USB adapter is
available if your LapTop/PC does not have a serial port. This version of uCal is housed in a black plastic case.

The USB version (uCal USB) utilizes a USB Port on your Laptop/PC. This version of the uCal is housed in a
silver aluminum case.

Connecting the uCal Programmer to your PC/Laptop

The uCal programmer is connected to your PC/Laptop with a standard RS-232 cable (supplied in the kit). An
optional USB adapter kit may be ordered if your PC/Laptop does not have a Serial port (RS-232).

Note: The uCal Programmer is powered by the DotLok unit, i.e. the uCal Programmer WILL NOT WORK un-
less connected to the DotLok Unit. The DotLok unit MUST ALSO be connected to a power source.

Optional USB Adapter Kit (for uCal)

The optional USB adapter kit Converts a standard USB port into a serial port that is compatible with the uCal
programmer. This kit also comes with a USB driver for Windows. This driver enables the standard uCal soft-
ware and programmer to be used with a USB port.

Installing the USB Driver for Windows (uCal)

Start your computer. Insert the USB Driver CD into your CD Drive. Plug the USB Connector (of the USB

to Serial Adapter) into a USB port on your PC/Laptop. Follow the on-screen instructions of Window’s device
manager. When the device manager is finished, you are ready to run the uCal software.

See the USB Driver Installation instructions (on the uCal CD) for specifics on Windows 98, ME, 2000 and XP.
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Connecting the uCal USB Programmer to your PC/Laptop
The uCal programmer is connected to your PC/Laptop with a standard USB cable (supplied in the kit). The

uCal USB Programmer is powered by the USB connection and does not need an external power source. The
DotLok unit, however, MUST be connected to a power source to function properly.

Installing the USB Driver for Windows (uCal USB)

uCal USB uses a driver that is different than for the USB adapter. The USB Adapter Driver WILL NOT WORK
with the uCal USB.

The Driver for uCal USB is located on the uCal CD, together with the application software.
Start your computer. Insert the uCal CD into your CD Drive. Plug the USB cable into uCal USB and into a
USB port on your PC/Laptop. Follow the on-screen instructions of Window’s device manager. When the de-

vice manager is finished, you are ready to run the uCal software.

See the USB Driver Installation instructions Appendix A, B for specifics..

Connecting the uCal Programmer to the DotLok Unit

Note: The uCal Programmer supports in vehicle programming (i.e. DotLok can be programmed while installed
in a lift truck) or regular bench top programming (DotLok is not installed in a lift truck).

A custom cable is supplied in the kit that connects the uCal programmer to the DotLok unit. Both ends of this
cable are identical. Either end connects to the DotLok or the uCal.

Starting the programming sequence (uCal)

Make Sure that the PC/Laptop software is installed before you start this step.

In-Vehicle Programming

1) Turn off the ignition switch in the lift truck

2) Connect the Serial (RS-232) Cable to both the PC/Laptop and the uCal Programmer
(use the optional USB adapter kit if your PC/Laptop is not equipped with a serial Port)

3) Connect the Custom Cable to both the DotLok and the uCal Programmer

4) Turn on the ignition key in the lift truck - DO NOT START THE LIFT TRUCK

5) Launch the DotLok Software on your PC/Laptop

Instructions for the PC/Laptop software are included below.



Desktop Programming (uCal)

Note: Desktop programming requires that the DotLok unit is connected to a 12V DC
power supply.

1) Turn off the 12V Power Supply
2) Connect the 12V Power Supply to DotLok (Both Positive and Ground)
(See DotLok installation instruction for Connector pin-outs etc.)
3) Connect the Serial (RS-232) Cable to both the PC/Laptop and the uCal Programmer
(use the optional USB adapter kit if your PC/Laptop is not equipped with a serial Port)
4) Connect the Custom Cable to both the DotLok and the uCal Programmer
5) Turn on the 12V Power Supply
6) Launch the DotLok Software on your PC/Laptop

Instructions for the PC/Laptop software are included below.

Connecting the uCal USB Programmer to the DotLok Unit

Note: The uCal USB Programmer supports in vehicle programming (i.e. DotLok can be programmed while
installed in a lift truck) or regular bench top programming (DotLok is not installed in a lift truck).

A custom cable is supplied in the kit that connects the uCal USB programmer to the DotLok unit. Both ends of
this cable are identical. Either end connects to the DotLok or the uCal USB.

Starting the programming sequence (uCal USB)

Make Sure that the PC/Laptop software is installed before you start this step.

In-Vehicle Programming

1) Turn off the ignition switch in the lift truck

2) Connect the USB Cable to both the PC/Laptop and the uCal USB Programmer
3) Connect the Custom Cable to both the DotLok and the uCal USB Programmer
4) Turn on the ignition key in the lift truck - DO NOT START THE LIFT TRUCK
5) Launch the DotLok Software on your PC/Laptop

Instructions for the PC/Laptop software are included below.



Desktop Programming (uCal USB)

Note: Desktop programming requires that the DotLok unit is connected to a 12V DC
power supply.

1) Turn off the 12V Power Supply
2) Connect the 12V Power Supply to DotLok (Both Positive and Ground)

(See DotLok installation instruction for Connector pin-outs etc.)
3) Connect the USB Cable to both the PC/Laptop and the uCal USB Programmer
4) Connect the Custom Cable to both the DotLok and the uCal USB Programmer
5) Turn on the 12V Power Supply
6) Launch the DotLok Software on your PC/Laptop

Instructions for the PC/Laptop software are included below.



Instructions for DotLok Software

The software that controls the Programming of the DotLok has three screens, a Main screen, an APPS Calcula-
tor screen, and a Help screen. Various messages and alerts are also employed. A picture of the main screen is
shown below.

The parameter data fields are described in detail in the “Programming Parameters” section of this document.

Main Screen

Dotlok - uCal Device Programmer - [C:\Program Files\PBWin7OAEE\DotLokhTest? . txt]

File Re-Flash APPS Calculator  Help
: (1 . l _
Current Settings uea New Settings
Spesd Limit (Low) [Hz] 50,085 Programuner for 8 bl vt (o) 2] 50
DotLok

Spd Limit [High] Delay [mS] 93,340 &pd Limit [High] Delay [mS] 100

5Spd Limit [Law] Delay [mS] 593.840 Spd Limit [Low) Delay [mS] 100

[ Enable Shift Abave Speed Limit (High] CURCRSInEtr o I Enabls Shift Abave Speed Limit (High)

Throttle Delay Throttle Delay
[ Enable Thrattle Del v Enable Throttle Del
nable Thrattle Delay APPC e nable Throttle Delay AP

Thrattle [Set Delay] [V] 2500 Throttle [Set Delay] [v] 1.3

Thiattle [Release Delay] [V] 1196 Bl Thiattle [Retease Delay] [V] 12

Thrattle Delay [mS] 500.000 SeralPord |y Thrattle Delay [mS] 500.000

HELF
Engine Brake Engine Brake
" Enable Engine Brake APPS APPS2 BT [+ Enable Engine Brake APPST APPS2
Eng. Brake Max Thrattle [v] | 1.089 | 0,534 s Eng. Brake Max Thrattle [V] | 11 0534
Enable Gear Max Throttle [+/] | 1.030 | 0.439 Enable Gear Max Thrattle [+] | 1.0 | 0439
[ Output Fault Detected [ Output Fault Detected
READ PROGRAM
Safety Spstems and Contrals, Inc. Dotlok w Eng. Brake @ Shifter [Low Side) Yersion 1.02

The border has the standard minimize, maximize and close button. It also shows the current file.
“Unsaved File” indicates that no file has been opened or saved.

The Current Settings area of the Screen contains all the Programming values that are either read
from DotLok (“Read” Button) or read from a file (“File -> Open”). The “Current Settings” area
is read only, i.e. it is not possible to edit any parameters in this screen area. The Print Command
Prints all parameters (Current and New Settings) shown on the Main screen, (File -> Print).

The New Settings area of the screen contains all parameters that are either programmed into the

DotLok (“Program” Button) or stored to a file (“File -> Save” or “File -> Save as). The Print
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Command Prints all parameters (Current and New Settings) shown on the Main screen, (File ->
Print).

The File Menu (top left corner) lets you Open, Save and Print Programming parameters. This
lets the user store programming parameters for different lift trucks etc. to be opened and re-used
at a later time. The programming parameters can also be printed. All the parameters that you
see on the screen (Current as well as New Settings) is what prints. Only the “New Settings”
programming parameters are stored to a file with the “Save” or “Save as” command. “Open”ing
a file puts the programming parameters from that file into the “Current Settings” area of the
screen - The “New Settings™ area of the screen is not updated.

The Re-Flash Menu provides a manual firmware upgrade of the uCal (and uCal USB) Program-
mers. This facilitates field upgrades of software and programmer firmware.

The APPS Calculator Menu enables a user to Calculate the the sensor readings from the second
Accellerator Pedal Position Sensor (APPS2), based on the first Accellerator Pedeal Position
Sensor (APPS1). A more detailed description is offered in the APPS Calculator section below.

The Help Menu activates the help screen. The help screen provides a description of all windows,
menues, buttons and programming parameters.

The Read Button transfers the current programming values from the DotLok into the “Current
Settings” area of the screen.

The Copy Parameters Button copies the “Current Settings” area of the screen to the “New Set-
tings” area of the screen

The Program Button re-programs DotLok with the programming values from the “New Settings”

area of the screen.
Note: Itis a good idea to read back the programming values into the “Current Settings” area of the screen after
you re-program the DotLok. This confirms that the DotLok accepted the new values/parameters.

The Help Button opens the help screen. The help screen provides a description of all windows,
menues, buttons and programming parameters.

The Select Serial Port Box has pop-up box that shows the currently selected serial port. If you
desire to chose a different port, simply select the port number from the pop-up box and click on
the “New Port” button. The uCal USB programmer also makes use of the serial port (Virtual
Serial Port) in order to maintain compatibility with the standard uCal programmer. If you are
un-sure of the port configuration on your PC/Laptop, use windows device manager to examine
your available ports.

The New Port Button Activates the new port.



APPS Calculator Screen

APPS_Calculator - [C:\Program Files\PBWin70\EE\Dotl ok\Test] . txt]

APPS Calculator

ADPPS Vollage
APPS Voltage vs. % Throttle
A[V)
VOT APPS1 APPS
VO APPS2 APPS 2
Idle APPST S
ldle AFFS2 % T hrottle
0w P—
{7 [0}
APPS Data Calculate APPS2 from Selected APPS1

Selected Yalues Calculated Yalues

WwOT APPS1 []|4.560 APPS1 APP52

WOT APPS2 [W] |2 260 Eng. Brake Max Thrattle [+] |1 00 Eng. Brake tax Throttle [+] | 0.534
Enable Gear Max Thrattle [+] |1 00 Enable Gear Max Thrattle [+] | 0434

dle 4PPS1 [¥] |0.745

Idle APPSZ [W] |0.357 Calculate APPSZ Copy ta Main Screen E wit ‘
Safety Spztems Controlz, [ne. Werzion 1.02

The APPS calculator utilises the linear relationship between %Throttle and the APSS sensor voltage. It is well
known that if we know two points (X & Y Coordinates) on a straight line we can determine the slope & Y inter-
cept of the line. If we call the slope k and the Y intercept m we can write an equation that describes the line as
follows: Y=k X+m

In this case Y is the APPS sensor output (in Volts) and X is the % Throttle.
If we determine that a particular APPS1 value is suitable for our application, it would be nice to be able to

calculate the corresponding APPS2 value. This would elimiate having to read two meters simultaneously, and
would also reduce the risk of setting un-necessary diagnostic error codes in the lift truck.




The APPS Calculator does exactly this. It utilizes the Idle and WOT parameters for APPS1 and APPS2 to deter-
mine the exact equations of the APPS Voltage vs. %Throttle curves for APPS1 and APPS2.

The APPS Calculator takes the parameters under the “Selected Values APPS1” and determines the correspond-
ing %Throttle (from the equation for APPS1) and then uses the %Throttle values in the equation for APPS2.

The two most practical points on the APPS Voltage vs. %Throttle curves for APPS1 and APPS2 are Idle and
Wide Open Throttle (WOT). These parameters can easily be measured on the lift truck without a need to drive
it. Simply turn on the ignition and measure the APPS1 and APPS2 sensor voltages with the accellerator pedal in
the idle position. Repeat the process, but with the accellerator pedal pushed all the way down.

Take these Idle and WOT readings for APPS1 and APPS2 and plug them into the appropriate data fields in the
“APPS Data” section of the APPS Calculator screen (lower left corner of the screen).

Determine the proper value of the Eng. Brake Max Throttle and the Enable Gear Max Throttle parameters
(APPSI) for your application. Plug these parameters into their respective data fields under the “Selected values
APPS1” section of the APPS Calculator screen.

Click on the “Calculate APPS2” button. The corresponding APPS2 values now appear un the “Calculated Val-
ues APPS2” section of your APPS Calculator screen.

Click on the “Copy to Main Screen” button and the Eng Brake Max Throttle & Enable Gear Max Throttle pa-
rameters for APPS1 and APPS2 on the APPS Calculator screen are copied to the appropriate data fileds on the
Main screen.

Click on the “Exit” button, and you return to the Main screen.

The Idle and WOT parameters for APPS1 and APPS2 are automatically saved along with all other parameters
when you select “Save” or “Save As” from the file menu.

The “Selected Values APPS1” parameters (Eng. Brake Max Throttle & Enable Gear Max Throttle) are automat-
ically imported from the Main screen when the APPS Calculator screen is opened.

The Calculate APPS2 Button calculates APPS2 values (Eng. Brake Max Throttle & Enable Gear
Max Throttle) based on the APPS1 values for the same parameters.

The Copy to Main Screen Button copies the Eng. Brake Max Throttle & Enable Gear Max Throttle
parameters (APPS1 and APPS2) from the APPS Calculator screen to the Main screen.

The Exit Button closes the APPS Calculator screen and returns to the Main screen.



Help Screen

uCal Help Window for DotlLok

Help is organized arvound the commands in the main window

sl e ]

|COFY Button |

The COPY Button is used to copy all parameters from Current Settings area of the screen
to the Mew Settings area of the gcreen. Mo Device Farameters are changed in the DotLok
unit.

The Current Settings area of the screen represents the values that are currently
stared in Dotlak. [tz neceszam to click on the BEAD button in order to tranzfer
the DiatLok parameter values to the Current Settings area of the screen

Enable Engine Braking enables a feature to hold the current gear, even if a different
gear iz selected, while traveling at a speed greater than the programmed Speed Limit
[High). It alzo limits the throttle voltage to the value programmed by the Engine Brake
tlax Throttle parameters [APPS1 and APPS2). This feature allows engine braking while the
lift-trck, slows down, even if a different gear iz selected. The cument gear is

- maintained unkil the lifttruck haz slowed down belows the Speed Limit [Low] parameter
AMD the throttle voltage is lezs than the Enable Gear Max Throttle parameter [APPS1.2).
The Speed Limit [Low] Delay parameter can be increazed to prevent the operatar from
trying to beat thiz system by gliding tires etc. The Thiottle Delay feature can alzo be
uzed to further require that the throttle position has to be maintained below a
programmed value - Throttle [Release Delay] dunng a gpecific amount of time - Throttle
Delay, before a new gear iz allowed to engage.
Engine Braking iz enabled by clicking an the Enable Engine Braking Check Bow.

Enable Gear Max Throttle is a parameter that iz part of the engine braking feature.

It iz uzed to prevent a new gear fram engaging until the throttle voltage iz less than
ExIT thiz parameter. Thiz prevents a lift-truck operator from engaging a gear with elevated bt

The uCal help Window for DotLok gives you a brief description of a programming parameter or a
“Button”. The scrollable window on your right list descriptions for all programming parameters
and “Buttons”.

The Select a Help Topic pop-up box lets you pick a topic of interest.

The Select Topic Button scrolls the window on your right to the topic you chose.

The Exit Button closes the help window and returns the Main window.



Programming Parameters

Only the “Current Settings™ area of the screen will be described, since the “Current Settings” area of the screen
is identical to the “New Settings” area of the screen. It should be noted, though, that only the “New Settings”
are of the screen allows editing.

Speed Limit (High) [Hz] is a parameter that sets the upper range of the speed limit. Speed Limit (High),
together with Speed Limit (Low) define a hysteresis range. Once the lift-truck speed has increased beyond the
Speed limit (High), it is necessary to reduce the lift-truck speed below Threshold Limit (Low) before DotLok
acknowledges that the lift truck is travelling below the speed limit. The reverse is also true. The programmable
range is 8 to 1,800 Hertz. Factory default is 10 Hertz.

Note: The programmer won’t allow Speed Limit (High) to be less than Speed limit (Low)

Speed Limit (Low) [Hz] is a parameter that sets what is considered to be below the speed limit. Speed imit
(Low), together with Speed Limit (High) define a hysteresis range. Once the lift-truck speed has decreased
below the Speed limit (Low), it is necessary to increase the lift-truck speed above Speed Limit (High) before
DotLok acknowledges that the lift truck is travelling above the speed limit. The reverse is also true. The pro-
grammable range is 8 to 1,800 Hertz. Factory default is 9 Hertz.

Note: The programmer won’t allow Speed Limit (Low) to be greater than Speed limit (High)

Speed Limit (High) Delay [mS] is a parameter that determines how long the lift-truck speed has to be main-
tained above the Speed Limit (High), before DotLok acknowledges this condition. This parameter works as a
filter to reduce hunting, cycling etc. The programmable range is 0.512 to 33,000 milli Seconds. Factory Default
is 100 mS.

Speed Limit (Low) Delay [mS] is a parameter that determines how long the lift-truck speed has to be main-
tained below the Speed Limit (Low), before DotLok acknowledges this condition. This parameter works as a
filter to reduce hunting, cycling etc. The programmable range is 0.512 to 33,000 milli Seconds. Factory Default
is 100 mS.

Enable Shift Above the Speed Limit (High) is a feature that enables gear shifts above the Speed Limit (High),
1.e. the lift-truck has to exceed a certain speed to enable gear shifts. This feature can be used to activate an
overdrive, taller gear etc. Leaving this feature un-selected enables gear shifts below the programmed speed - the
Speed Limit (Low) parameter. The Enable Shift Above Threshold (High) feature is activated by clicking on the
check box in the New Settings area of your screen (You also have to click on the PROGRAM Button).

Factory Default is unselected.

Enable Throttle Delay is a feature that prevents the transmission from engaging a gear until the throttle voltage
is reduced below a programmed level (Throttle Release Delay) and has stayed there throughout a programmed
time interval (Throttle Delay). Throttle Set Delay represents the Throttle voltage at which the Throttle delay is
reset (the operator cannot engage a gear). Thottle Set Delay and Throttle Release Delay define a hysteresis range
to reduce noise and interference sensitivity. The Throttle Delay feature reduces the chance that an operator
engages a gear at elevated RPMs. The enable Throttle Delay feature is activated by clicking on the check box in
the New Settings area of your screen (it is also necessary to click on the PROGRAM Button).

Note: the Throttle delay only uses APPS1. APPS2 is ignored.

Throttle (Set Delay) [V] is the throttle voltage at which your lift-truck won’t engage a gear. This parameter
is part of the programmable throttle delay, see enable Throttle Delay for more information on this topic. The
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programmable range is 0.5 to 5 Volts. This parameter also has to be set higher than the Throttle Release Delay
parameter of the programmable Throttle Delay. The factory default is 1.3 Volts.

Throttle (Release Delay) [V] is the maximum Throttle voltage at which the transmission is allowed to engage
a gear. This prevents the transmission from engaging a gear at elevated RPMs. Also see Enable Throttle Delay
above. The programmable range is 0.5 to 5 Volts. Factory default is 1.2 Volts.

Throttle Delay [mS] is part of the Throttle Delay feature. This parameter programs the amount of time the
throttle has to be kept below the programmed Throttle Release Delay Voltage before the transmission of the
lift-truck is allowed to engage a gear. Also see Enable Throttle Delay above. The Factory Default is 500 milli
Seconds.

Enable Engine Brake enables a feature that maintains the current gear, even if a different gear is selected. It
also limits the throttle voltage to the values programmed by the Eng Brake Max Thottle parameters (APPS1 &
APPS2). The current gear is only maintained if the lift truck is travelling above the speed limit when another
gear is selected. This feature allows engine brake while the lift-truck slows down, even if a different gear is se-
lected. The current gear is maintained until the lift-truck has slowed down below the Speed Limit (Low) speed
parameter AND the throttle voltage is less than the Enable Gear Max Throttle parameter. Full throttle is restored
if the operator returns the gear selector to the original poistion and releases the accellerator pedal. The Speed
Limit (Low) Delay parameter can be increased to prevent the operator from trying to beat this system by sliding
tires etc. The Throttle Delay feature can also be used to further require that the Throttle voltage has to be main-
tained below the Throttle Release Delay parameter for an amount of time (Throttle Delay) before a new gear is
allowed to engage. Engine brake is enabled by clicking on the Enable Engine brake check box (it is also neces-
sary to click on the PROGRAM Button).

Engine Brake Max Throttle [V] is part of the Engine brake feature. It is a parameter that limits the maximum
throttle during engine brake. This limit only comes into effect if another gear is selected when the lift-truck is
traveling at a speed higher than the programmed Speed Limit. Also see Enable Engine brake above. The pro-
grammable range is 0.5 to 5 Volts (APPS1) and 0.25 to 5 Volts (APPS2).

Factory default is 1.1 Volts (APPS1) and 0.53 Volts (APPS2).

Enable Gear Max Throttle [V] is another parameter that is part of the Engine brake feature. It is used to set a
throttle voltage threshold to prevent a new gear from engaging until the throttle voltage is less than this param-
eter. This prevent a lift-truck operator from accidentally engaging a gear at elevated RPMs. This feature only
comes into play when the Enable Engine brake check box is checked AND the lift-truck is traveling at an el-
evated speed AND the gear selector is moved into another position. Also see the description of the Engine brake
feature above. The programmable range is 0.5 to 5 Volts (APPS1) and 0.25 to 5 Volts (APPS2).

Factory default is 1 Volt (APPS1) and 0.5 Volts (APPS2).

Output Fault Detected indicates (in the Current Settings area of your screen) if an output fault has occurred.
An output fault is a condition where forward and reverse gears are attempted to be engaged simultaneously.
DotLok has safety mechanisms that prevent a gear from engaging, if another gear is already engaged. This is the
mechanism that also triggers the Output Fault Detected Light (Solid RED light in the DotLok). Any fault code
is stored in Flash memory inside the DotLok. The Fault Light can be cleared by toggling the ignition key of the
lift-truck. However, the fault code that is stored in Flash memory can only be cleared with a uCal Programmer.
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The procedure for clearing a code is as follows:

Click the READ button to read DotLok parameters

Click the COPY button to move the data to the NEW Settings screen area
Click on the Output Fault Detected check box to clear the code

Click on the PROGRAM Button

Quick Start Guide

Required Materials

DotLok Device w/ harness

uCal programmer for DotLok (Cables and CD w/ software included)
Laptop or PC

Digital Multimeter w/ built-in frequency counter (Hz setting)

Preparations

It is a good idea to verify that the DotLok is installed correctly, please refer to installation instructions.
Also verify if the DotLok application software is installed on your Laptop/PC. The application software is
already installed on your Laptop/PC if you can locate a blue forklift icon on the desktop, with the legend
DotLok

Installing the DotLok Application Software

The uCal programmer comes with the necessary cables and a CD containing the application software and
product documentation (this manual). Proceed by installing the application software if it is not already installed
on your Laptop/PC. Insert the uCal CD into your CD Drive. Open the DotLok folder on the uCal CD. Click on
the “Install DotLok™ icon. Follow the on-screen instructions.

Device Driver Installation

You do not need to install any device drivers if you are using the standard uCal (Black Plastic case) without the
USB adapter kit.

If you are using the standar uCal (Black plastic case) with the USB adapter kit, you need to locate the separate
CD containing the device drivers. Insert this CD into your cd drive. Plug the USB adapter into your USB port
on your Laptop/PC. Follow the on-screen instructions. There are detailed device driver installation instructions
on the uCal CD.

If you are using the uCal USB, insert the uCal CD into your CD drive. locate the supplied USB cable and plug it

in to uCal and your Laptop/PC. Follow the onscreen installation instructions. Detailed installation instructions
are supplied in Appendix A and B of this document.

Data Gathering

Start by determining the critical parameters, i.e. the parameters that affect the operation of the DotLok the
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most. These parameters usually are the speed limit, the throttle voltage for the throttle delay, and the
throttle voltages for engine brake. If you plan on not using some of the available features, just ignore the
corresponding parameters. This example will illustrate the use of all available features.

The Speed Limit

The Speed limit will be selected relatively close to the idle speed. A speed limit that is set too high will reduce
the effectiveness of the DotLok system. Too low a setting will result in excessive operator complaints. We start
by measuring the pulse rate of the vehicle speed sensor while running the lift truck at idle. These measurements
are taken with a multimeter at the Hz setting. Also take measurement from the vehicle speed sensor when

the lift truck is running at a speed that is borfer line too fast. These two measurements set the boundaries of a
practical speed range for the Speed limit parameters.

Example: Idle Speed = 420 Hz, Second measurement (upper boundary) is 650 Hz.

We choose 550 Hz for Speed Limit (Low) and 600 Hz for Speed Limit (High). This means that the lift truck
has to travel slower than the 550 Hz speed to engage a gear and stay below the 600 Hz speed to continue to
allow gears to be enabled. Decrease these settings (Speed Limits High & Low) if they support a driving style
that is too aggressive. Increase these parameters if you get too many operator complaints.

The two Speed Limit parameters define hysteresis. More hysteresis (the parameter values are further apart)
results in less noise sensitivity but a more sluggish system response. A good compromise is about 10%
hysteresis.

The Speed Limit Delays can be left at the factory settings (100 milli Seconds) for now. Higher delay values
result in longer activation times and lower sensitivity to noise etc. Lower delay values result in increased
sensitivity to noise etc. and shorter activation times. Delays times that are too short may result in “hunting”, i.e.
the system oscillates between engaging and disengaging transmission shifts. Too Long Delay times results in an
unresponsive or sluggish system. 100 milli seconds is a good starting point. Increase the Delay times if your
operators appear to “beat the system”.

Throttle Delay

The Throttle Delay forces the operator to let the engine rev down before a gear is engaged.

Start by measuring the signal from the Accelerator Pedal Position Sensor (APPS) with the accelerator pedal in
the idle position. This is easily done with a multimeter set on DC Voltage. It is necessary to turn the ignition
key on to power-up the APPS sensor. If your lift truck has two APPS Sensors, you have to determine which
sensor is APPS1 and which is APPS2. The sensor with the highest voltage at idle is APPS1. Also take a second
reading of APPS1 at an RPM that is considered border line too high to allow a gear to engage. The second
reading constitute the upper boundary.

Example Idle Speed (APPS1) = 0.75 Volts and Upper boundary = 1.5 Volts

We choose 1.1 Volts for the Throttle (Release Delay) parameter and 1.25 Volts for the Throttle (Set Delay)
parameter. Higher values result in a more aggressive driving style and lower values tend to better preserve the
equipment. The Throttle (Release Delay) and (Set Delay) also define hysteresis. A hysteresis of around 10%
appears to work well for most applications.

We choose a 1000 milli Second delay for the Throttle Delay parameter. This means that we budget 1 second for
the engine to rev down after the operator get off the accelerator pedal. Increase this delay if your engine revs
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down slower. You may also decrease this delay to allow a more aggressive driving style.
Engine Brake

The Engine Brake option provides unconditional engine brake while “coasting” or slowing the lift truck

down, even if the operator have shifted the gear selector out of the original gear. The engine brake feature is
only activated if the lift truck is traveling above the programmed speed limit AND the operator shifts the gear
selector out of the original gear. The APPS Voltages are reduced to a value determined by the Eng. Brake Max
Throttle parameters during engine braking. The new gear is engaged only after the truck has slowed down
below the Speed limit (Speed Limit Low parameter) AND the operator has let up on the accelerator pedal
(APPS voltages are lower than the Enable Gear Max Throttle).

Start by measuring the APPS1 and APPS2 voltages at idle. It is necessary to have the ignition key in the on
position to do this, but the engine may be shut off. Also measure the APPS1 and APPS2 voltage during Wide
Open Throttle (WOT). Remember that APPSI is always the larger reading.

Example: Idle APPS1 = 0.75 Volts, Idle APPS2 = 0.357 Volts, WOT APPS1 = 4.56 Volts, WOT APPS2 =2.26
Volts.

Select a value (APPS1) for the Enable Gear Max Throttle parameter. This value should be relatively close to
the idle voltage of APPS1. To low a value will undoubtedly result in too many operator complaints. Too high a
value will add stress to the equipment.

Also select a value (APPS1) for the Eng Brake Max Throttle. This parameter should represent a land speed that
is low enough to be considered safe, even if an operator is initially confused by this system.

Example: Enable Gear Max Throttle (APPS1) =1 Volt, Engine Brake Max Throttle (APPS1) = 1.1 Volts

The next step is to determine the corresponding APPS2 parameter values. We will make use of the APPS
Calculator in the DotLok software package to do this.

Before you proceed, make sure that the DotLok unit is installed in the lift truck and that you have a Laptop

at your disposure. You can use a PC instead of a Laptop. Also make sure that you have an uCal programmer
for the DotLok system. The uCal programmer comes with the necessary cables and a CD containing the
application software and product documentation (this manual). Proceed by installing the application software if

it is not already installed on your Laptop/PC. The application software is already installed on your Laptop/PC if
you can locate a blue forklift icon on the desktop, with the legend DotLok.

uCal Programmer Set-up
The programmer set-up consists of the following steps:

Make sure that the DotLok unit is properly installed in the lift truck; see DotLok installation instruction for
details.

Turn the ignition key of the lift truck off.
Turn on your Laptop/PC. Wait until your Laptop/PC is finished booting Windows.

Hook up the uCal programmer to your Laptop/PC.
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If the device manager on your Laptop/PC detects a new device, make sure you insert the separate driver CD
into your CD Drive if you are using the regular uCal w/ USB adapter (uCal w/ black plastic case) or insert the
uCal CD into your CD drive if you are using uCal USB (uCal w/ silver aluminum case). Follow the on-screen
instruction to install the necessary drivers. Also see Appendix A and B of this document for detailed driver
installation instructions.

Launch the DotLok application software on your Laptop/PC

Connect the DotLok unit to the uCal programmer with the supplied cable (both ends of the cable are identical
and mate with ether the uCal programmer or DotLok)

Turn the ignition key of the lift truck on - DO NOT Start the engine

A solid red light should now be visible on the DotLok. A solid red light means that the DotLok is maintaining a
data connection with the uCal Programmer. The Red light begins to blink if the data connection is lost.

Click on the “READ” button of the Main screen. This transfer the pre-programmed parameters of the DotLok
to the Current Settings are of the screen.

Click on the “Copy Parameters” button to copy all parameters from the Current Settings area of the screen to the
New Settings area of the Screen.

Key in all the parameters we selected in the previous examples, into the “New Settings” area of the screen.

Select “APPS Calculator” from the Menu in the top left corner of the screen. This brings up the APPS
Calculator screen.

Key in the Idle and WOT parameters for APPS1 and APPS2 in the “APPS Data” section of the APPS Calculator
screen (Lower Left Corner).

Key in the Eng Brake Max Throttle and the Enable Gear Max Throttle parameter values for APPS1 that we
selected earlier, into the “Selected Values APPS1” area of the screen

Click on the “Calculate APPS2” button. This calculates the corresponding APPS2 parameter values.

Click on the “Copy to Main Screen” button. This transfers the Eng Brake Max Throttle and the Enable Gear
Max Throttle values (APPS1 and APPS2) into the appropriate fields of the Main screen.

Click on the “Exit” button to return to the Main screen.

Verify that all parameter values in the New Settings area of the screen are correct.

Click on the “Enable Throttle Delay” check box if you want to activate the throttle delay feature.
Click on the “Enable Engine Brake” check box if you want to activate the engine brake feature.

Select “Save As” from the File Menu in the upper left corner of the screen.
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Choose a file name to save the parameter values of the “New Settings” area of the screen to.
The Idle and WOT values for APPS1 and APPS2 are saved as well.
Hint: use a file name that is descriptive of the type of lift truck and/or application.

Choose “Print” from the File Menu if you want a hard copy of all parameter values.

Click on the “Program” button to reprogram the DotLok. Your Laptop will respond with a double beep if
programming was successful.

Click on the “Read” button to read the parameter values (from the DotLok) into the “Current Settings” area
of the screen. Compare all parameter values of the “Current Settings” are of the screen to those of the “New
Settings” area of the screen to make sure the new values are in effect.

Turn the ignition key in the lift truck off and disconnect the cable from the DotLok when you are finished.

You are now ready to take the lift truck for a test ride to make sure the DotLok performs as intended. You may
want to reconnect the uCal programmer and tweak, or fine tune some of the parameter values.

Hint: It may be easier to fine tune the DotLok if you start out with the Throttle Delay and the Engine Brake
disabled (check box is clear). This way you can isolate the Speed limit and Speed limit Delay parameters.

When the shift interlock function is tuned to your satisfaction, enable the Throttle Delay and fine tune it.
Finally, enable the Engine Brake feature and fine tune it.

For additional information, please do not hesitate to contact Safety Systems & Controls at 713/465-8839
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Appendix A
This appendix covers the installation of device drivers for the uCal USB under Windows 98 and ME.

NOTE: These device drivers WILL NOT work with the USB adapter - see separate instructions on the uCal CD
and device drivers on a separate CD.
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Appendix B
This appendix covers the installation of device drivers for the uCal USB under Windows 2000 and XP.

NOTE: These device drivers WILL NOT work with the USB adapter - see separate instructions on the uCal CD
and device drivers on a separate CD.
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